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B Introduction
This guide provides reference information for the use of external devices with the NA. It does not provide

safety information.
Be sure to obtain the NA-series Programmable Terminal User's Manuals, read and understand the safety

points and other information required for use, and test sufficiently before actually using the equipment.



Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

® Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and
workmanship for a period of twelve months from the date of sale by Omron (or such other period
expressed in writing by Omron). Omron disclaims all other warranties, express or implied.

® Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED,
ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS
DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS
OF THEIR INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses
based on infringement by the Products or otherwise of any intellectual property right.

® Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or replacement
thereof) the non-complying Product, (ii) repair the non-complying Product, or (iii) repay or
credit Buyer an amount equal to the purchase price of the non-complying Product; provided
that in no event shall Omron be responsible for warranty, repair, indemnity or any other
claims or expenses regarding the Products unless Omron’s analysis confirms that the
Products were properly handled, stored, installed and maintained and not subject to
contamination, abuse, misuse or inappropriate modification. Return of any Products by
Buyer must be approved in writing by Omron before shipment. Omron Companies shall not
be liable for the suitability or unsuitability or the results from the use of Products in
combination with any electrical or electronic components, circuits, system assemblies or
any other materials or substances or environments. Any advice, recommendations or
information given orally or in writing, are not to be construed as an amendment or addition
to the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published
information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR
COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER
SUCH CLAIM IS BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT
LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the
Product on which liability is asserted.



Application Considerations

I Suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or
regulations which apply to the combination of the Product in the Buyer's application or use
of the Product. At Buyer’s request, Omron will provide applicable third party certification
documents identifying ratings and limitations of use which apply to the Product. This
information by itself is not sufficient for a complete determination of the suitability of the
Product in combination with the end product, machine, system, or other application or use.
Buyer shall be solely responsible for determining appropriateness of the particular Product
with respect to Buyer’s application, product or system. Buyer shall take application
responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO
LIFE OR PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS
BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable
Product, or any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a
guide for the user in determining suitability and does not constitute a warranty. It may
represent the result of Omron’s test conditions, and the user must correlate it to actual
application requirements. Actual performance is subject to the Omron’s Warranty and
Limitations of Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons. It is our practice to change part numbers when published
ratings or features are changed, or when significant construction changes are made.
However, some specifications of the Product may be changed without any notice. When in
doubt, special part numbers may be assigned to fix or establish key specifications for your
application. Please consult with your Omron’s representative at any time to confirm actual
specifications of purchased Product.

I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical or proofreading
errors or omissions.
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1 Related Manuals

The following manuals are related to this manual.

Cat. No. Model Manual name

W473 CJ2H-CPU6O-EIP SYSMAC CJ Series CJ2 CPU Unit Software
CJ2H-CPU6] User’s Manual
cJ2m-cPuOO-

W501 NX701-O0000 NJ/NX-series CPU Unit Software
NJ501-00000 User’s Manual

NJ301-00000
NJ101-00O000

W506 NX701-0000 NJ/NX-series CPU Unit Built-in EtherNet/IP™ Port
NJ501-000000 User’s Manual

NJ301-0000
NJ101-0000

W504 SYSMAC-SE21[10] Sysmac Studio Version 1 Operation Manual

W502 NX701-0O00 NJ/NX-series Instructions Reference Manual
NJ501-00000
NJ301-00000
NJ101-0000

V118 NAS5-15wO 000 NA-series Programmable Terminal Software
NAS-12wOOdd User’s Manual

NA5-owOI OO0
NA5-7wWO OO0

V119 NA5-15wO OO0 NA-series Programmable Terminal Device Connection
NA5S-12wO000 User’'s Manual

NA5-owWOI OO0
NAS-7WO OO0

V120 NA5-15wO OO0 NA-series Programmable Terminal Startup Guide
NA5S-12wO000
NA5-owI OO0
NA5S-7WO OO0




2 Precautions

(1) When building an actual system, check the specifications of the component devices of the
system, use within the ratings and specified performance, and implement safety measures
such as safety circuits to minimize the possibility of an accident.

(2) For safe use of the system, obtain the manuals of the component devices of the system
and check the information in each manual, including safety precautions, precautions for
safe use.

(3) It is the responsibility of the customer to check all laws, regulations, and standards that the
system must comply with.

(4) All rights reserved. No part of this publication may be reproduced, stored in a retrieval
system, or transmitted, in any form, or by any means, mechanical, electronic, photocopying,
recording, or otherwise, without the prior written permission of OMRON.

(5) The information in this guide is current as of April 2015.

No patent liability is assumed with respect to the use of the information contained herein.
Moreover, because OMRON is constantly striving to improve its high-quality products, the
information contained in this guide is subject to change without notice.

(6) The operation of each design template has tested using the device configuration indicated
in section 4-1 of this guide. The operation of screens after incorporation of the templates is
not guaranteed.

Special information in this document is classified as follows:

@ Precautions for Safe Use

Indicates precautions on what to do and what not to do to ensure safe usage of the
product.

B Precautions for Correct Use

Indicates precautions on what to do and what not to do to ensure proper operation and
performance.

|j$ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operation easier.

Copyrights and Trademarks

Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation
in Japan and other countries for OMRON factory automation products.

Screenshots are used in accordance with Microsoft Corporation guidelines.

Windows is a registered trademark of Microsoft Corporation in the USA and other
countries. EtherCAT® is registered trademark and patented technology, licensed by
Beckhoff Automation GmbH, Germany. Company names and product names in this
document are the trademarks or registered trademarks of their respective companies.




3 Introduction

“ Variable reference path of internal devices
&) variable reference path of NA External Device
- Variable mapping path

The NA series has the ability to combine Sysmac devices and manage them in one project file.
In addition, other devices including the Sysmac products and CJ series in other project files
can be communicated by importing the variables or addresses. Omron is considering making
the NA series manageable with controllers from other companies in the future. Devices in

other project files are registered and managed as "External Device".

This guide describes how to import settings from the connected devices to perform
communication between the NA and the CJ or NJ/NX series that is set as External Device.

Concept of Variable Import

The Sysmac Studio provides an integrated development environment to Sysmac devices.
When the NA and NJ/NX series are managed in one project, the NJ/NX variable information
can be shared in the project. (*1)

Even if a Controller that you want to refer is not in the same project, the variable information
still can be shared by being recognized the Controller as External Device and capturing the
variable information. (¥2)

Sysmac Studio project

NJ/NX: Internal device NA
[
' Page 1
Programl —
Local
Local variable variable
Script Object
Command/FB S e |

Global
variable

Global
variable

Variable
mappjng

Device variable

*1 tatle *2

{device vaniabla Variable import
colunn)

The "variable import" is a process that loads the variable information of the External Device
into the project in the Sysmac Studio. After importing, data can be read from or written to the
External Device by assigning the external device variables to the NA variables in the variable
mapping setting.



4 External Device Tab Page in Sysmac Studio

The External Devices are registered under “Configurations and
Setup” - “Device References” in the Multiview Explorer of the LSO s =

Sysmac Studio. ] Corfoursions andsetup |

After devices are registered, the following tab page appears for
each device.

The items displayed in the “Device Configuration” and
“Communications Configuration” Columns depend on the type of
connected device.

For the details, refer to the relevant section for connecting the devices in this guide.

_- ExternalDevice0 X =

¥ Device Configuration
Device Configuration - r Communications Configuration
Device Name ExternalDeviced © IP Address @ Route Path

Device Vendor Omron IP Address |

Communication Driver CIP Ethernet Encoding us-asci v

E Communication Error Indication

Import Status Not Imported. v

Comment

The “Name”, “Data Type”, “Comment”, and “AT” are shown in the “Device Variables” Column,
from left to right.
Each item is explained below.

® Name

A name of the variable registered in the connected External Device.

You can set a variable name by importing the variables or adding variables.

If no variable name is registered, the communication fails between the NA and External
Device.

® Data Type

A variable data type. Since this information is used to determine a data size, you must enter
the data type even the address is already assigned to “ AT".

® Comment

A comment to variable. You do not necessarily have to enter a comment for the control.
® AT

The information to be referred when the variable is assigned to the physical addresses.
The memory assigned to “AT” is accessed.
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4-1

How to Import External Device Variables

There are the following three methods to import the variable information of the External Device
with the Sysmac Studio version 1.13.

1) Importing and updating variables directly from device
2) Direct entry

3) Copy and paste

Other project file Sys_mac .SIUdiO
Project file

Variable

@Direct entry
®Copy and past
Screen transfer

Importing and
updating variables
directly from device

Mapped variable

External Device
NJ/NX series
CJ series

NA series

® Importing and updating variables directly from device
Variables can be imported directly from the External Device by connecting the device to the
computer with an Ethernet cable. Since the CIP protocol is used to query the tag variables to

the NJ/NX in this method, the variables are imported based on the CIP rules. This method is
applied to the OMRON devices that support CIP.

The "Update Variables" function imports only the differences in the changed variable
information of the External Device.

® Direct entry

The user can directly enter the variable information in the “Device Variables” Column of the

Sysmac Studio. Data Type and AT must be entered accurately according to the defined
notation rules.

® Copy and paste

The variable information can be copied from Excel, notepad or other text editor and pasted to
the “Device Variables” Column of the Sysmac Studio. This method allows the user to edit a
large amount of variables easier than using the direct entry.

@D Copying from Excel

Describe one item per cell. The items must be entered in the same order as the “Device
Variables” Column of the Sysmac Studio, as shown below.

Name (variable) Data Type Comment Address/Value (AT)
Testl BOOL abc EO_0000.01
Test2 DINT def 0001

11
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Except the heading lines in the Excel, all of the variable information must be copied and pasted
to the “Device Variables” Column of the Sysmac Studio.

@ Copying from notepad or other text editor
The variable information can be copied from notepad, word file, or other text editor and pasted
to the “Device Variables” Column of the Sysmac Studio. The items can be separated by the

[Tab] key on the keyboard. The items must be described in the same order as the "(1)
Copying from Excel".

testl + BOOL -
test2 + BOOL -
testd -+ BOOL -

|j$ Additional Information

There is no restriction on the number of variables to import, but there is limit to the
number of variables to assign to the NA global variables in the variable mapping; 20,000
mapped variables per External Device and 35,000 variables for the entire project.

|j$ Additional Information
When multiple NA devices are registered in one project, the External Device can be
referred from the multiple NA devices.

In this case, the variables must be imported by all of the multiple NA devices in the
external device setting.

E% Additional Information

When entering a variable name in the “Device Variables” Column of the Sysmac Studio,
the prohibited character is in accordance with the prohibited character of the External

Device. The prohibited character for mapped variables is the same as for the NA global
variables.




4-2 The Merge Device Variables Dialog Box of Sysmac Studio

¥ Device Configuration
Device Configuration ————————— ~Communications Configuration

Entering the IP address of the External Device Devie Name O 1P Adress @ Route path
. Device Vendor —
enables the “Update Variables” Button of =

Device Series W] Timeout

Import StatUS. Communication Driver  [GIP Ethernet Encoding us-ascii

i i Ei Communication Error Indication
The following dialog box appears when the —— T
“Update Variables “ Button is pressed. P——

The same items are displayed on the screen regardless of devices.
You can use the same procedure regardless of devices.
| Bi| Merge Device Variables

Target Device Variable Source Device Variable
| Name |Data Type|Comment|AT| | Name |Data Type|Comment|AT|
DINT1 DINT 1 DINT
DINTZ DINT DINTZ UDINT
DINT3 DINT DINT3 UINT
DINT6 DINT
DINT?
DINT
DINT

5 | DINT

«; Copy All Right to Left

ﬂ Data Types are successfully updated.

On the screen, the variable in the External Device is compared with the value in the “Device
Variables” Column of the Sysmac Studio, and the differences can be applied to the “Device
Variables” Column from the External Device. But a reverse operation is impossible (i.e.,
unable to change the variable information in the Sysmac Studio and apply the differences to
the External Device).

The following items are displayed on the screen.

® Target Device Variable

A list of the variables registered in the “Device Variables” Column of the Sysmac Studio.
Next to each number, the comparison result of the variables between the target external
device and the source external device is displayed in a color that is shown in the legend.

® Source Device Variable

A list of the variables stored in the External Device.

Next to each number, the comparison result of the variables between the target external
device and the source external device is displayed in a color that is shown in the legend.

13
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® |Legend

The results of the comparison are displayed in the following colours.

-Red: The name in the target and source devices are the same, but the data types are
different.

-Green:The variable exists in only the target device (Sysmac Studio). This disappears after
the difference is copied and applied.

-Blue:The variable exists in only the source device (External Device). The difference in
variables can be copied to the Sysmac Studio.

-Yellow:The copied variables. In this status, the variables have not been copied to the
“Device Variables” Column of the Sysmac Studio. Therefore, the copied variables are not
applied to the “Device Variables” Column even after the “Merge Device Variable” Dialog Box is
closed. You need to click the "Apply” Button to apply the results of copying to the “Device
Variables” Column.

® “Copy Selected Right to Left” Button

This button merges the selected lines of variables from the source device (External Device) to
the target device (Sysmac Studio).

Even this button is simply clicked, the results of copying is not applied to the "Device Variables”
Column. To apply the results of copying, you need to click the "Apply” Button.

® “Copy All Right to Left” Button

This button merges all of the differences between the two devices from the source device
(External Device) to the target device (Sysmac Studio). Even this button is simply clicked, the
results of copying is not applied to the "Device Variables” Column. To apply the results of
copying, you need to click the "Apply” Button.

® “Undo Selected” Button
This button undoes the selected copy operation. You can undo the copy operations only
before clicking the “Apply” Button.

® “Undo All’ Button
This button undoes all of the copy operations before clicking the “Apply” Button.

® “Apply” Button

This button finalizes the copied variables and applies the result to the “Device Variables”
Column. After the result is applied, the colors of "legend” disappear and the variables in
the "Target Device Variable” and "Source Device Variable” Fields become the same.



4-3 Supported Devices and Applicable Variable Import Methods

There are the following three methods to import variable information of the External Device.
Applicable methods and restrictions depend on the type of External Device.
The import methods for each External Device are as follows.

Method | Importing and updating Direct entry (note 2) Copy and paste( note 2)
variables directly from
Device type device (note 1)
NJ/NX Supported Supported Supported
CJ-CIP Supported Supported Supported
CJ-FINS Not supported Supported (note 3) Supported (note 3)
Note 1)

The following table shows whether “Importing and updating variables directly from device” is
supported by each variable.

eVariable Sys_tem-defined _ U_ser-defined variables
\variables Not published Publish Only Input Output
Device type
NJ/NX Supported Not supported Supported Supported Supported
CJ-CIP Not supported Not supported Supported Supported Supported
(note 4)
Note 2)
A building error occurs if a data type that you entered is not within the “IntelliSense” scope.
For this reason, you cannot neither define structures nor enter the external device variables in
the “Data Type” Field.
Note 3)
For the CJ-FINS, AT (address) must be entered.
For information on how to enter AT (address), refer to the “Address/Value” Field of the CX-
Programmer variable table.
Note 4)
CJ system-defined variables don't have the “Publish” setting. Also, the user can not add this
setting to the variables. For this reason, the CJ system-defined variables cannot be imported
by any variable import method.
|j$ Additional Information
When importing the NJ/NX variables, the user-defined variables and the system-defined
variables are imported together.
The CJ-CIP system-defined variables cannot be imported since this variable cannot be
set as network variable.
4-4  Import Information of External Device Variable Table

To import the external device variable and the physical address information and use them in
the NA, you must define the data type regardless of the import method.

15



The following table shows whether the “Device Variables” Column of the Sysmac Studio must be

entered.
Device type Name (variable) Data Type Comment Address/Value (AT)
NJ/NX Required Required Optional Not required
CJ-CIP Required Required Optional Not required
CJ-FINS Required Required Optional Required

Eﬁ Additional Information

A variable name for the CJ-FINS must be entered. If the CJ project file is designed only
with physical address, you must define the variable to the physical address to be
imported to the NA.

16




4-5 Data Type

The NA uses the Visual Basic data type. The data name and type are different from IE61131
that is used in the CJ or NJ/NX series.

The “Device Variables” Column of the Sysmac Studio must be entered in the IE61131 data
type, as same as the CJ or NJ/NX.

When using the “importing and updating variables directly from device “method, the IE61131
data type set by the External Device is automatically loaded during the import. When using the
"direct entry" or "copy and paste" method, the user must manually enter in the IE61131 data
type. The Visual Basic data type can be assigned in the “variable mapping” setting.

When importing variables with the NJ, NX, or CJ-CIP, you don’t need to be aware of the data
length. When importing the variable assigned to the physical addresses with the CJ-FINS, if
the data type is declared with the Sysmac Studio, the data is loaded for the data type length,
starting from the beginning of the physical address given to AT.

Eﬂs Additional Information

The range of physical addresses to be referred depends on the data type.
Example) For a LREAL data set to DM000O, the addresses from DM000O to DM0003
are used since the LREAL variable is 4-word (eight bytes).

Image of assigned address

LREAL variable

|j$ Additional Information

If two variables of different data types are set to the same address, they are normally
operated respectively. In this case, the two variables are shared. If any change is made
to the one, the other changes accordingly.

Example) When address is 11, DINT variable is 11, WORD variable is B.

If the variable is an array, consecutive addresses are assigned starting from the entered
address. The interval of the assigned address depends on the data type of the array
variable.

Example) For a DINT variable when the variable name is "Test", number of array is "3",
and set address is "EO_0000".

In this case, the address of array number 0 is "EO_0000", number 1 is "EQ_0002", and
number 2 is "EQ_0004".

17



Image of assigned address

Test(0) Test(l) Test(2)

For a BOOL variable, one array is in units of one bit. When the number of array is “3”
and the address is set to "EO_0000", the address of array number 0 is "EO_0000.00",
number 1 is "EO_0000.01", and number 2 is "EO_0000.02".

4-6 Notation for AT (Physical Addresses)
This section describes the notation for AT that is required to import variables to the CJ-FINS
External Devices using the "direct entry” or "copy and paste" method.
To enter AT (address), refer to the “Address/Value” Field of the CX-Programmer variable table.
® For the CIO area "CIO 0001", enter only the numerical parts in the address. If above two
digits are all 0, you can omit O to enter. For "0001", enter "1".
® For "EO_0001", enter "EO_0001" as it is. If above two digits are all 0, you can omit 0 to
enter. For "EO_0001", enter "EO_1".
® For a BOOL variable, enter a value in a range of 00 and 15 to two decimal places of the
address.
4-7 How to Input Data Type of Array Variables
Array variables can be set by all the input methods.
The input methods for each device type are as follows.
NJ/NX Importing and "Array[start point of array..end point of array] of data type” is automatically entered
updating variables | in the “Data Type” Field.
directly from device
Direct entry Enter "Array[start point of array..end point of array] of data type” in the “Data Type”
Copy and paste Field.
Example) number of array for DINT variable is 10 :"Array [0..9] of DINT".
CJ-CIP Importing and "Data type [number of array]” is automatically entered in the “Data Type” Field.
updating variables
directly from device
Direct entry Enter "Data type [number of array]” in the “Data Type” Field.
Copy and paste Example) For DINT variable when number of array is 10 :DINT[9]
CJ-FINS Direct entry Enter "Data type [number of array]” in the “Data Type” Field.
Copy and paste Example) For DINT variable when number of array is 10 :DINT[9]

18




4-8

Import Availability for Data Type Variables

Whether the import is available for each device is as follows.

NJ/NX Importing and Available.
updating variables | However, variables of the union and enumeration types cannot be imported.
directly from device
Direct entry Not available because an error occurs if a data type that you entered is not within
the “IntelliSense” scope.
Copy and paste Not available because an error occurs if a data type that you entered is not within
the “IntelliSense” scope.
CJ-CIP Importing and Available.
updating variables | However, the system-defined variables cannot be imported.
directly from device
Direct entry Not available because an error occurs if a data type that you entered is not within
the “IntelliSense” scope.
Copy and paste Not available because an error occurs if a data type that you entered is not within
the “IntelliSense” scope.
CJ-FINS Direct entry Not available because an error occurs if a data type that you entered is not within

the “IntelliSense” scope.

Copy and paste

Not available because an error occurs if a data type that you entered is not within
the “IntelliSense” scope.
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5 When NJ/NX is Connected

This section explains how to import the variables when the NJ/NX is set as External Device.
Refer to the next section for how to import NJ/NX variables.

=
Additional Information

As an example, the following screen uses “NJ” device to explain the procedure.
When you use NX, replace the description of “NJ” with “NX” in the following procedure,
as the same procedure as “NJ” is used for “NX” to import variables.

5-1 Window to Set NJ/NX as External Device

This section explains the window that sets the NJ/NX External Device.
The following window appears by right-clicking “Device References” -> “Add” ->
“ExternalDevice”, and select “NJ” or “NX” for the “Device Series” Field.

¥ Device Configuration

~Device Configuration —————— ~ Communications Confiouration ————

Device Name ExternalDeviced IP Adc

vice Vendor Omron v Timeout

v Ei Communication Error Indication

IP Address: Enter the address of the connected NJ/NX. Example)”192.168.250.1"
Device Series: Select the types of the connected External Device from “CJ",“NJ”, or
“NX.

Import Status: The import result and date are shown after importing the variable.
Import Variables/ Update Variables:When the External Device is connected with an
Ethernet cable, click the “Import Variables” or “Update Variables” Button to import or
update the variables.

® Device Variables: Variables that are imported from the External Device are shown.

®O O

5-2 Importing Variables when External Device is NJ/NX

There are the following three methods to import variables when the “NJ” or "NX” is set as
External Device.

® Importing and updating variables directly from device

® Direct entry

® Copy and paste from Excel or other files

Refer to the next page for each variable import method.
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5-3

Importing and Updating Variables Directly from Device

This method directly imports the variable information from the NJ/NX by connecting the NJ/NX
to the PC that imports the variables with an Ethernet cable.

As the CIP protocol is used in this method, only the exposed variables in publish setting (set
to "Publish Only”, “Input”, or “Output”) of system-defined and user-defined can be imported
among the NJ/NX global variables.

=% Additional Information

If all of the global variables to import is set to “Do not publish” in the NJ/NX, only the
NJ/NX system-defined variables will be imported.

All of the variables are imported by pressing the “Import Variables” Button.

Individual variable cannot be selected whether to import or not.

You can import only the difference in the variable information by pressing the “Update
Variables” Button.

Perform the following procedure to import and update variables directly from the NJ/NX.

B Importing variables from the NJ/NX Unit

1

Set the variable to the global variable
of the NJ/NX in the Sysmac Studio. Multiview Explorer s Global Variables x

Set the variable to other than "Do
2 not publish”.

3 Transfer the setting to the NJ/NX.
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Open New Project and click “Device
4 References” -> “Add” -> B New Project - AHLNASL6 " Sames SUSTI
"ExternalDeVICe” to Fde Edit View Insert Project HMI Simulation Tools Help

X @ @@

add "ExternalDevice0”. &

HMI_NAS_0

Select “NJ” or “NX” for the “Device
5 Series” Field and enter the IP
address of the device. ¥ Device Configuration

Device Name BT IP Address 192 .168.250. _1

Device Vendaor Timeout 2
Device Series Ei Communication Error Indication

Communication Driver

Import Status NotImported. ¥

Import Variables Update Variables

6 Click the “Import Variables” Button.
The user-defined variables are —
imported under the system-defined
variables of the NJ/NX. SCONON |

| woro

_MC s WORD

MC_GRP | Arayio 3t ol 5 |
MC_GRP ErSta Arag[031) of W
_PLC_frrsea WORD
PowerGnCount | vomT

_PowerOnkicur UDINT
Arvary{0.1] of USINT

=
Additional Information

Variables are imported based on CIP protocol rules, so the global variables set to “Do
not publish” in "Network Publish” cannot be imported.

=% Additional Information

Structure variables can be imported in the same way as for regular variables.
Data variables of unions and enumerations that are not supported by the NA cannot be
imported.
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After the variable is imported, you can import only the differences in the variables that were
changed or added by the External Device by clicking the “Update Variables” Button next to the
“Import Variables” Button. You do not necessarily have to click the “Import Variables” Button
before “Update Variables” Button.

Perform the following procedure to import the differences in the NJ/NX variables by clicking

the “Update Variables” Button.
B “Update” procedure

On the External Device0O Tab Page,
1 select “NJ” or “NX” for the “Device

Series” Field and enter the IP ¥ Device Configuration
H H - Device Configuration ———————— ~Communications Configuration —
i\ddress of th_e dev!’ce, and click the Doee N bl
Update Variables™ Button. Device Vendor Ormron v || Timeout —

Device Series [ v Ei Communication Error Indication

Communication Driver Ethemet v

Import Status NotImported. | ¥

TSNS
2 After clicking the “Update Variables”

Button, the pop-up page appears as [ verge Device Varizble
shown on the right.  note 1)

Target Device Variable Source Device Variable
Neme|Data Type] ~ Comment | | ) | DataType |Comment]
WORD

BackupBusy
Card1Access

Select the variable on the right side
and click the
“Copy Selected Right to Left” or

“Copy All Right to Left” Button.

Card1BkupCmd
Card1BkupSta
Card1Deteriorated
CardlEr
Card1PowerFail
Card1Protect
Card1Ready
Card1VefySta

_CIB_CBUODInitSta

o
1
2
3
4
5
6
7
8
9

B_CBUO4Rest L
_CJ5_CBUOSInitsta |BOOL ||
CJB_CBUOSR:

[l Data Types are successfully updated.

Notel ) The variables stored in the External Device are displayed at the right side of the pop-up page.
At the left side, the “Device Variables” Column of the connected External Device is displayed.

After the variables are copied at the
3 left side, click the ”"Apply” Button to
apply the results.

————
Jzaa=]t+

" Merge Davice Variable:

Target Device Variable Source Device Variable
Name |Data Type|Comment| | Name |Data Type|Comment|
. . 12 _CIB_SIO20Restart  BOOL
After the results are applied, click SO 1Initse | BOOL

_CJB_SIO21Restart _CJB SIO21Restart BOOL
2InitSta BOOL

the "Close” Button to close the pop- o siozzintta 5901

up page E _CIB SI023nitSta  BOOL
. = _CIB SI023Restart BOOL
_CIB_SIO24InitSta BOOL
_CIB_SIO24Restart BOOL
CIB_SI025nitSta  BOOL
102 BOOL

i BOOL
_CIB SIO26Restart BOOL
_CIB SIO27InitSta BOOL
BOOL

BOOL
_CIB_SIO28Restart BOOL
_CIB_SIO29InitSta  BOOL
IB_SIS BOOL
BOOL

BOOL

BOOL

BOOL

o

The copied variable is added in the
4 “Device Variables” Column.

_CIb_SKEnitsta
CIB_SI02Restant BOOL
_CB_SKFnitsts | BooL
CIB IRt BOOL
Bo0L [ |
CIR_SI07dRestart OO
_CIB SISt BOOL
CIR_SI0T5Restat |'woot
_CIB_SIt BOOL
CIR_SIZ6Restart |'woo
_CIB_SI0E S BOOL
RS0 Rastart |woot
_CIB_SI0EtEs BOOL
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5-4 Direct Entry

In this method, you can directly enter variables in the “Device Variables” Column of the
Sysmac Studio. Regardless of the publish setting in the global variable table of the NJ/NX
variables can be registered.

= Additional Information

A tag comparison error occurs after transferring the variable information to the NA if the
variable information that you entered is different from the information in the NJ/NX.
The following items are checked during the tag comparison.

-Variable name, structures name, structure member name

-Variable data type, structure data type, structure member data type

-Number of array for variables, number of array for structures, number of array for
structure member

B "Direct entry” procedure

On the External Device0O Tab Page,
1 select “NJ” or “NX” for the “Device
Series” Field and enter the IP ¥ Device Configuration

Device Configuration ———————— ~Communications Configuration

Device Name ExternalDevice0 IP Address 192 .168 .250. _1
Device Vendor Omron v || Timeout —

address of the device.

Device Series NJ v K Communication Error Indication

Communication Driver Ethemet v

Import Status NotImported. ¥

Import Variables Update Variables

Enter a variable name for the “Name”
2 Filed and the variable data type for

the “Data Type” Field of the “Device

Variables” Column.

Note 1)

After transferring the data to the NA,

3 make sure that no error occurs and
the screen starts normally, which
means the operation ends
successfully.

=% Additional Information

When entering array variables, enter "Array[start point of array..end point of array] of
variable name” in the “Data Type” Field.
Example) For DINT variable when number of array is 10:"Array [0..9] of DINT”
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5-5

Copy and Paste

In addition to the direct entry, you can copy the variable information from Excel or text files and
paste it to the “Device Variables” Column of the Sysmac Studio. To copy and paste the
information to the “Device Variables” Column, the variable information must be placed in the

specified order in the file.

B "Copy & paste” procedure

1

Input the variables that you want to

copy to the Sysmac Studio in the B2 ]|
Excel sheet. A B & D E F
1
2
The OI"deI" iS 8 Marme Data Type Comment AT
4
Name-> Data Type-> Comment-> AT, | | = e
from left to right. 6 stz BOOL
. “ » 7 testd BOOL
You do not need to input “Comment 5 testd  BOOL
“ ” 9 tests BOOL
and "AT". 10 testh BOOL
1 test? BOOL
12 testd BOOL
13 testd BO0OL
14 testi0 BOOL
15
16
Copy the variables in the Excel sheet.
2 B2 |
A B o] 8] E F
. 1
Make sure that the data in 2
“Comment” and “AT” is also copied 3 Mare__| Data.Type [Comment |AT
4 t L
even they are blank. . i
*The heading lines on top are given f test2  BOOL
H 3
only for explanation, so exclude the ; T
headings when you copy the 8 tests  BOOL
: H : 10 testh BOOL
variables information. T e oL
12 tastd BOOL
18 testd BOOL
14 test10 BOOL

In the “Device Variables” Column,
right-click and select “Paste” or
“Ctrl+V” to paste the variables.

-
el
et
test]

Ctest
-
[
(=
et
[
it

BRERREERER!
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6 When CJ-CIP is Connected

This section explains how to import the variables when the CJ2 is set as External Device.
Refer to the next page for the procedures to import the CJ-CIP variables.

6-1

26

Window to Set CJ-CIP as External Device

This section explains the window that sets the CJ-CIP External Device.

The following window appears by right-clicking “Device References” -> “Add” ->
“ExternalDevice”, and selecting CJ for the “Device Series” Field, and CIP Ethernet for
the "Communication Driver” Field.

S)

©O® OO

®

®© 6 00

¥ Device Configuration
- Device Configuration ———————— — Communications Confiquration
Device Name ternal -6 © IP Address @ Route Path

Device Vendor IP Address E
Device Series Timeout shconds

Communication Driver Encoding us-ascii v

E Communication Error Indication

mport Status

¥ Device Vanables

Data Type | Comment

IP Address: The “IP Address” Filed is displayed for the connected device if the "IP
Address” Check Box is selected. Example)”192.168.250.1"

*Refer to the following “Additional Information” for information on the “Route path” Check
Box.

Device Series: Select the types of the connected External Device from “CJ”, “NJ”, or “NX".
Communication Driver: Either "CIP-Ethernet” or "FINS-Ethernet” can be chosen for the
CJ. "CIP-Ethernet” is selected here.

Import Status: The import result and date are shown after importing the variable.

Import Variables/ Update Variables :When the External Device is connected with an
Ethernet cable, click the “Import Variables” or “Update Variables” Button to import or
update the variables.

Device Variables: Variables that are imported from the External Device are shown.

=
Additional Information

When the “Route path” Check Box is selected in the “Communications Configuration”
Column, the “IP Address” Field changes to the “Route Path” Field.
The “Route Path” Field is used when connecting the Communications Configuration ———————

@ IP Address O Route Path
External Device via router. ——

imeout
The entry format is "Port No.%address”. Frenimy — =
Example) 1%192 168 250 30 B Communication Error Indication




6-2

6-3

Importing Variables when External Device is CJ-CIP

There are the following three methods to import variables when the CJ-CIP is set as External
Device.

® Importing and updating variables directly from device

® Direct entry

® Copy and paste from Excel or other files

Refer to the next page for each variable import method.

Importing and Updating Variables Directly from Device

This method directly imports the variable information from the CJ by connecting the CJ to the
PC that imports the variables with an Ethernet cable.

As the CIP protocol is used in this method, the variable import is available within the CIP
function scope that is supported by the CJ.

|j$ Additional Information

Unlike the NJ/NX, the CJ cannot import its system-defined variables. Only the variables
whose network address is set and the address is allocated by the CX-Programmer can
be imported to the Sysmac Studio.

All of the variables are imported by pressing the “Import Variables” Button.

Individual variable cannot be selected whether to import or not.

You can import only the difference in the variable information by pressing the “Update
Variables” Button.

Perform the following procedure to import and update variables directly from the CJ.

Importing variables from the CJ

1

Click “Device References” -> “Add” |
~ “ExternalDevice” to (] New Project - HMI_NAS_0 - Sysmae ST

add "ExternalDevice0".

File Edit WView Insert Project HMI Simulation Tools Help

|+ 2 e a|l:nam KA

L ] Internal Device:
+* Variable Mapping

/.. Language Settings

v EXT—

¥ [ Pages

Select CJ for the “Device Series”
2 Field, CIP-Ethernet for the

“Communication Driver” Field and ¥ Device Configuration

enter the IP address Of the deVice. Device Configuration ———— ~Communications Configuration

Device Name tarna ) © 1P Address @ Route Path
Device Vendor Omron 1P Address

Device Series Timeout

Communication Driver Encoding us-ascii

Ei Communication Error Indication
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3

Connect the CJ with an Ethernet
cable and click the “Import Variables”
Button.

¥ Device Configuration

~ Devi nfiguration —————— ~ Communications Configuration

Device Name O 1P Address @ Route Path

Device Vendor Omron 1P Addr

Device Series o Timeout seconds
Communication Driver  [CIP Ethernet Encoding us-ascii A

E Communication Error Indication

Import Status NotIlmported. ¥

Update Varabies

¥ Device Vanables

Data Type Comment

Make sure that the CJ variables are

automatically entered in the “Device

Variables” Column, which means the
operation ends successfully.

Cnce Cemipitition

192 .168.250. _2

il -

o Update succeyshul on 201507730 1600:31°

arishles | Upeate Varishles ot Froum File_
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After the variable is imported, you can import only the differences in the variables that were
changed or added by the External Device by clicking the “Update Variables” Button next to the

“Import Variables” Button. You do not necessarily have to click the “Import Variables” Button
before “Update Variables” Button.

Perform the following procedure to import the differences in the CJ variables by clicking the

“Update Variables” Button.

B “Update” procedure

1

On the External Device0O Tab Page,
select CJ for the “Device Series”
Field, CIP-Ethernet for the
“Communication Driver” Field and
enter the IP address of the device.

w Device Configuration

nfiguration
Device Vendor Omron sl
Device Series [¥] v

Communication Driver  [CIP Ethernet

Import Status

After clicking the “Update Variables”
Button, the pop-up page appears as
shown on the right. note 1)

Select the variable and click the
“Copy Selected Right to Left” or
“Copy All Right to Left” Button.

ne ExternalDevice0

~Communications Configuration

© IP Address @ Route Path

IP Address. 192.168._5.__5

Encoding — v

K communication Error Indication

Notel ) The variables stored in the External Device are displayed at the right side of the pop-up page.

® At the left side, the “Device Variables” Column of the connected External Device

is displayed.

3

After the variables are copied at the
left side, click the ”"Apply” Button to
apply the results.

After the results are applied, click
the "Close” Button to close the pop-
up page.

4

The copied variable is added in the
“Device Variables” Column.
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6-4

Direct Entry

In this method, you can directly enter a variable name in the “Device Variables” Column of the
Sysmac Studio. Between the NA and CJ is communicated with variable names, so you don't

need to enter in the “AT” Field for the CJ-CIP.

= Additional Information

When communicating with the CJ-CIP, a tag comparison error occurs after transferring
the variable information to the NA if the variable information that you entered is different

from the information in the CJ Unit.
The following items are checked during the tag comparison.

-Variable name, structure name, structure member name

-Variable data type, structure data type, structure member data type
-Number of array for variables, number of array for structures, number of array for

structure member

B "Direct entry” procedure

1

Click “Device References” -> “Add”
-> “ExternalDevice” to
add "ExternalDevice0".

|H] New Project - HMI_NAS_O - Sysmac

File Edit
[
|

Multiview Explorer -5

View Insert Project HMI  Simulation Tools Help

& G @

2

Select CJ for the “Device Series”
Field and enter the IP address of the
device.

3

Enter the “Name” and “Data Type”
Fields of the “Device Variables”
Column.

After transferring the information to
the device, make sure that no error
occurs and the device operates
normally.

= Additional Information

For array variables, enter "data type [number of array]” in the “Data Type” Field.
Example) For DINT variable when number of array is 10:DINT[9]
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©6-5 Copy and Paste

In addition to the direct entry, you can copy the variable information from Excel or text files and
paste it to the “Device Variables” Column of the Sysmac Studio. To copy and paste the
information to the “Device Variables” Column, the variable information must be placed in the
specified order in the file.

The variable information cannot be copied directly from the CX-Programmer and pasted to the
“Device Variables” Column of the Sysmac Studio. However, the information of the CX-
Programmer can be copied from Excel or text files and pasted.

Perform the following procedure to copy the information of the CX-Programmer from Excel
and paste it to the “Device Variables” Column.

B "Copy & paste” procedure

Open the variable table of the CX- e e s ' om0
1 Programmer, select the variables, — ¢ e warD w70 Work | EMBdrea Par -

- . “ ” —P_EMA WORD 2471 Work  EM Areapay =) STt Symbol..
right-click-> select “Copy" or press —p v woRD s Work EVB Area par ImpattNetwork sl
the [Ctrl+C] keys to copy the Sy wers o2 Mok avea g 2 e s
variables. = e T v o ot o e s 23T

LDINT -
I Lt
I
I
I I
I 2
[ Delete
E—r— '
work 0,01 second clock pulse bit
0 wark  0L02 second clock pulse bit
> Paste the copied data in the Excel P B [ ¢ 1 e T F T @
sheet. 2 Mame Data Type Address/Value  Comment hetWariahle
S| DINTO DINT EO O TRUE 0
The address information % Bm?g gﬂ Egi $§3§ g
“Address/Value” is pasted together 8 DINTE ~ OINT  EOS TRUE 0
A H H T ” 7 DINT4 DINT EO 8 TRUE 0

even it is not required in this “CJ-CIP” | ~ e er Ebic TRUE B

method. 9 DINTG  DINT E012 TRUE 0
10 DINT? DINT EO_14 TRUE 0
. . . 1 DINTS DINT EO16 TRUE o)

*The heading lines on top are given 12 DINTS  DINT E01B TRUE 0
only for explanation. The headings % DINT1O _DIMT__ FO 20 TRUE 9
are not entered even if they are
copied and pasted.

Change the order of the pasted data A B o] D E

3 as follows: 1

“Name-> Data Type-> Comment-> 2 Mame Data Tvpe Comment  Address/alue

Address/Value” 5 DINTO DIMT EQO
4 DINTA DINT E0.2

You can leave “Comment” and 5 DINTZ  DINT E04

“Address/Value” blank but “Name” 8 DINTS __IDINT E0.6
d “Data T " tbh tered Fi DINT 4 CINT ED &

and Data lype mustbe entered, B DINTS  DINT E010
otherwise an error occurs after they g DINTE DINT E012
are pasted. 10 DINT? DINT ED 14

11 DINTS DINT ED16
12 DINTS CINT ED18
13 DINT10  DINT E0.20
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4 Copy the variable in the Excel sheet. A [ B [ o [ b | E [ F

MName Ciata Type Comment  Address/Valus

Copy the four columns including
“Name”, “Data Type”, “Comment”,
and “Address/Value”.

Be sure to copy the four columns
even if “Comment” is blank.

*Exclude the heading lines on top
such as “Name”, “Data Type” etc.,
when you copy the variables
information.

In the “Device Variables” Column,

5 right-click and select “Paste” or press
the [Ctrl+V] key to paste the
variables.
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7 When CJ-FINS is Connected

This section explains how to import the variables when the CJ2 is set as External Device.
Refer to the next page for the procedures to import the CJ-FINS variables.

/-1 Window to Set CJ- FINS as External Device

This section explains the window that sets the CJ-FINS External Device.

The following window appears by right-clicking “Device References” -> “Add” ->
“ExternalDevice”, and selecting CJ for the “Device Series” Field, and FINS Ethernet for
the "Communication Driver” Field.

¥ Device Configuration

- Device Configuration ~ Communications Configuration

Device Name arnall ) || Network Address

| Node Address
Frame Length

FINS Ethernet
E Communication Error Indication

Import Status

¥ Device Vanables

Data Type | Comment

Network Address: Enter the network address of the External Device. Use the "CX-Net
network configuration tool” to set a network address.

Node Address: Enter the node address of the External Device. Enter the 4™ series of
numeric values of the IP address. Example) For "192.168.250.10", node address is "10".
Device Series: Select the types of the connected External Device from “CJ”, “NJ”, or “NX".
Communication Driver: Either "CIP-Ethernet” or "FINS-Ethernet” can be chosen for the
CJ. "FINS-Ethernet” is selected here.

Device Variables: Variables that are imported from the External Device are shown.

When "FINS-Ethernet” is selected, you must enter the physical address in the "AT” Field.
Refer to the next page for the address range.

© ®0 © O
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/-2 Address Range

When using the FINS for the communication, you must enter the applicable variable address.
The upper limit and the applicable area range of the address depend on the device model.
For the details, refer to the relevant manual of the device used.

The address range is as follow:

Area Description Range Word access Bit access Example
Read-in Write Read-in Write of AT
CIO CIO area 00000 to 06143 Available | Available | Available Available 0000
HR Holding area 00000 to 00511 | Available | Available | Available | Available H0000
00000 to 01471 Partially Partially
AR Auxiliary area | 100001011535 1 siniiaple | _ MO0 | Available not A0000
available . "
%1 available*1
T Timer process 00000 to 04095 Available | Available Not Not TO000
value available available
C Counter process 00000 to 04095 Available | Available Not Not C0000
value available available
DM Data memory 00000 to 32767 Available | Available | Available | Available D0000
EMO to EM area 00000 to 32767 Available | Available | Available | Available E0_0000
EM18 E1 0000
WR Work area 00000 to 00511 Available | Available | Available | Available WO0000
TU Timer completion 00000 to 04095 Not Not Available Not TUO0000
flag available | available available
Cu Completion flag 00000 to 04095 Not Not Available Not CuU0000
available | available available

*1:Some addresses cannot be written.

/-3
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Importing the CJ-FINS Variables

The CJ-FINS cannot import the variables from the CJ.
There are the following two methods to import variables when the CJ-FINS is set as External

Device.
® Direct entry

® Copy and paste from Excel or other files

When using the “Copy and paste from Excel or other files” method, you can get the source
information from the following two windows of the CX-Programmer.
(@D Variable table: To copy the physical address with a comment.

@ Usage overview with comments: To copy the physical address accessed with the ladder

programming.

Refer to the next page for each variable import method.

Eﬁ Additional Information

For the CJ-FINS, the variable names or data types are not necessary to be the same as
the variables in the CJ, but the accurate address must be entered in AT.

E% Additional Information

As the FINS protocol is used for the communication, variables that require the definition
of data type such as structure variable are not supported.




/-4 Direct Entry

In this method, you can directly enter a variable name in the “Device Variables” Column of the
Sysmac Studio.

Between the NA and CJ is communicated with the physical address, you don’t need to enter in
the “AT” Field.

You don’t necessarily have to use the CX-Programmer to set variables.

B "Direct entry” procedure
1 Click “Device References” -> “Add”

-> “ExternalDevice” to " New Project - HMI_NAS 0 - Sysmac Suaio
add “ExternalDevice0”. File Edit View Insert Project HMI Simulation Tools Help

4 G d

Multiview Explorer -1

HMLNAS_0 =T

Ay Languag;

v E

W [ Pages

Select CJ for the “Device Series”
2 Field and FINS Ethernet for the — —
“Communication Driver” Field. .

[y

cation Error Indication

¥ Device Variables

DotaType | Comment

Enter the “Network Address” and
3 “Node Address” Fields. D

Enter the variable information in the Mame Data Type Address | Yalue

4 “Device Variables” Column. o test2 DINT[100] E0_L
i Test3 BOOL Fr.nt

= Test_DINT DINT Eﬂiﬂ

When using the variables set in the
CX-Programmer, entre the “AT” Field
by referring to “Address/Value”
corresponding to the variable.

The variable name can be different
from the name described in the CX-
Programmer.

For the variable that is not set in the
CX-Programmer, refer to the table in
7-2 "Address Range” when entering
the "AT” Field.

35



Change FINS Settings on the HMI
5 Settings Tab. =
Frame Length s
In the “FINS Address” Column, < [ o B ] scconcs
enter the network address value that : & Commmuncation Emor indicaton
you entered in Step 3 to the “Ethernet | [l =

port” Field of Network.

Make sure that no error occurs when
6 the NA starts and the values are

displayed normally, which means the

operation ends successfully.

it
Additional Information

For a BOOL variable, enter a value in a range of 00 and 15 to two decimal places of the
address.

If the value of decimal places is not set to the address of the BOOL variable, a tag
comparison error occurs when the NA starts.

Example) 0000.00
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/-5 Copy and Paste

In addition to the direct entry, you can copy the variable information of the External Device to
Excel or text files and paste it to the “Device Variables” Column of the Sysmac Studio.

The variable information cannot be copied directly from the CX-Programmer and pasted to the
“Device Variables” Column of the Sysmac Studio. However, the information of the CX-
Programmer can be copied from Excel or text files and pasted.

To copy and paste the information to the “Device Variables” Column, the variable information
must be placed in the specified order in the file.

You can copy AT information from the "Variable table” or ” Usage overview with comments” in
the CX-Programmer. Use any one of the two methods as appropriate.

Variable table Displays and obtains a list of the variables for all of the memory areas and the
physical address with comments. The address without comment cannot be added to
the list even the address is used in the program.

Usage overview with Displays all of the address used with ladder in the project for each memory area
comments regardless with/without a comment. You need to copy the physical address for each
memory area.

B "Copy & paste” procedure using "variable table”
This section explains how to copy the variable name and data type in the "Variable table” of the CX-
Programmer, and paste it to the “Device Variables” Column of the Sysmac Studio.

|j$ Additional Information
If a comment is given to the address used in the CJ program, it is automatically added to
the variable table as a variable without a name. If no comment is given, the variable is
not added to the variable table.
If you want to refer to the NA communication address with this method, give a comment
to the physical address.

|j$ Additional Information

A building error occurs when pasting the variable to the Sysmac Studio, if a variable
name is blank. To avoid the error, a variable name must be added in the Excel sheet.

|j$ Additional Information

Only the "BOOL" or "CHANNEL" data type can be used for a variable (physical address)
without a name. For this reason, if you want to change the data type as desired, copy
the data type from the CX-Programmer to a file before changing the data type.
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: _ Nams Dats Type Address | Value | Met. Varisble Rack Location | Lisags | Comment
1 Open the Vanable table Of the CX — P10 WORD A430 work  CIO Area Parameter
PI’Ogrammer, select the Varlables, © p_Cycle_Time_Error  BOOL A401.08 Work  Cycle Time Error Flag
. . “ ” Al ‘Work DM Area Parameter
right-click-> select “Copy” or press
the [Ctrl+C] keys to copy the B /o omment
variables. 3 [nsert Symbal. .
= = Iraport Metwark Yarisble. .
iz Jowr [ encoofpubicaton | [ NSNS
» Large Icons
e Small Teans
List
Detals
Delste
2 Paste the copied data in the Excel ‘ : ‘ I ‘ ‘ I
A B c D E F G H I
sheet. ;
2
3 [Wall BOOL 001 Testl TRUE Q
4 [Wal2 BOOL Q1 Test2 TRUE Q
5 EOOL 11 Test3 Q
[i] BEOOL 21 Testd (o]
7 BOOL 215 Tests o
8 BOOL EQ 1000 Testd o]
a Wal? DIMT E0_ 200 Test? TRUE o
10 CHANNEL ED_300 Testd Q
11 CHANNEL FO 100 Testd Q
12
13
3 Change the order of the pasted data G132 - =
as follows: A B E 8] E F
“Name-> Data Type-> Comment-> i
dd NValue” 2 Mame Data Type Comment  Address,Value
Address/Value”. 3 Valt BOOL  Testt a0t
4 WalZ BOOL TestZ a4
B EBOOL Test3 141
4] BOOL Testd 21
7 BOOL  Tests 215
g BOOL  Testd E0_10.00
] val7 DINT Test7 E0_200
10 CHAMMEL Test8 ED_300
11 CHARMMNEL Testd EO_100
12
13
4 Add variable names to “Name” if , Gi8 - %
they are blank. . & H o o E £
| 2 Mame Data Tvpe Comment Address/Value
3 Valt BOOL  Testl o)
4 Val2 BOOL Test2 a1
B Vald BOOL Test3 11
4] Wald BOOL Testd 21
7 Vals BOOL Testo 215
g Valg BOOL  Testd E0_10.00
9 Val? DINT Test? ED_200
10 Valg SHAMNMEL Test8 ED_300
11 Val9 SHAMMEL Testd ED_100
12
13
Change the data types as desired in H14 - S
5 the Excel sheet. A B s D E F
1
Z [WET =] Data Type Comment  Address/Value
)
If you don’t need to make any 3 A BOOL  Test! 0.1
change, skip this step. 4 Valz BOOL  Test? 01
5] Wald BOOL Test3 11
G Val BOOL  Testd 21
7 Va5 BOOL  Tests 215
g Walf BOOL Testf EC_10.00
] vall DINT Test? E0_200
10 Valg UINT Testd E0_300
11 “Wald ULINT Testd EC_100
12
13
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6

Copy the variables that you edited in 537 d &

the Excel sheet. A B C D E F

1

. . 2 Marne Data Tvee Comment  Address/Value
Copy the four columns including 3 valt BOOL  Testt 001
Name", "Data Type ', “Comment ", 4 Val2 BOOL  Test2 01

and “Address/Value. 5 Va3 BOOL  Test3 1.

& Val4 BOOL  Testd 21

7 Vals BOOL TestS 215
Be sure to copy the four columns g Valé BOOL  Test6 E0 1000
even if there are any blank columns. ] Val7 DINT Test? E0_200

10 Val UINT Tests E0_300

11 Valg ULINT  Test9 ED 100

mEEm 0

v Device Configuration

In the “Device Variables” Column,

7 right-click and select “Paste” or click e e -t e e e

the [Ctrl+V] key to paste the Device Nams Network Address

. Device Vendor [ornen | Node Address
variables. S -
Device Series €] Frame Length 2000
Communication Driver  [AINS Ethemet | Timeout
Encoding E——

Ei Communication Error Indication

Import Status Notimported. v

Tmport From File...

SEEEEEEEE
EEERBRARE
§

o
Additional Information
For a BOOL variable, enter a value in a range of 00 and 15 to two decimal places of the
address.
If the value of decimal places is not set to the address of the BOOL variable, a tag
comparison error occurs when the NA starts.
Example) 0000.00

"Copy & paste” procedure” using “usage overview with comments”
This section explains how to copy the address in the ” Usage overview with comments” of the CX-
Programmer, add the variable information, and paste it to the “Device Variables” Column of the Sysmac

Studio.

=8 Additional Information
The “Usage overview with comments” displays the used variables regardless with or
without a comment. A report can be created only for each address area.

= Additional Information
A building error occurs when pasting the variable to the Sysmac Studio if a variable
name is blank. To avoid the error, a variable name must be added in the Excel sheet.

—
Additional Information
The "BOOL” or "CHANNEL" data type only can be used for a variable (physical address)
without a name. For this reason, if you want to change the data type as desired, copy
the data type from the CX-Programmer to a file before changing the data type.

39



Select "View” -> “Cross-Reference
1 Report” in the CX-Programmer to
display the cross-reference report.

File Edit
0O

Insert PLC Program  Simulation Tools  Wind

Symbals .
[@ Diagram

Mremonics

Al+D

Memory Yiew

\%

[re Edt vew Inset FLC Progem Smustion Took Window Help

DFd o &R LalE MRV QTR A e[ L =
. S Y - 4 b 4% W) o0 E L I ML
DEBREOS e || Aas N WAL T
iF L N LY
Newomet =2 [ Aeooavoe: (TSI -] Meoroes [ ] e
8 ceHesar{o] olfies
'_.'_ouu!m-':
2 symocks
10 Table and Link Sstup
eklrap
e
ngzvmmm
& Spubeis
2 Select "Usage overview with
comments” from the “Report type”
pull-down list. Fepart tupe: | Detailed usage | Memary arex: |A -
Detaded usage
Usage overview including unused
Usage with comments including unused
Usage with comments [S55 format)
Dupbcate usage over programs

Select the address area to display

3 from the “Memory area” pull-down
list, and click the “Generate” Button to
display the “Usage overview with
Comments”.

Fiepor type: |Usage averview with comments v | Memary ares Generate

Select the variable to copy from the

4 displayed list, and right-click and
select “Copy” or click the [Ctrl+C] key
to copy the variables.

Report type: |Llsage averview with comments j Memory area; I\D -I Generate

Free UM: 410054 Steps
TotalUn: 410624 Steps

Address | Chatiel ‘ Uszage

| Enntact| Cail | Symbol | Comments
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Paste the copied data in the Excel
sheet.

Delete the blanks and change the
order of the pasted data as follows:
“Name-> Data Type-> Comment->
Address/Value”.

Add variable names to “Name” if
they are blank.

Enter the data types in the Excel
sheet.

To set a BOOL variable, enter a
value in a range of 00 and 15 to
two decimal places in
“Address/Value”.

Copy the variables that you edited in
the Excel sheet.

Copy the four columns including
“Name”, “Data type”, “Comment”,
and “Address/Value.

Be sure to copy the four columns
even if there are blank columns.

10

In the “Device Variables” Column,
right-click and select “Paste” or click
the [Ctrl+V] key to paste the
variables.

ones Configuration

B3 - £ 001
a | B | ¢ [ D [ E [ F ] G " ]
0.01 1 Wiork, 1 Vall Test]
0.1 1 ok 1 Wal2 Test2
1.1 1 Work, 1 Testd
21 1 tiork 1 Testd
215 1 ok, 1 Testh
100 1 titork
200 1 tilork
Fi1 - fe|
A B C O E F
1
2 MName Data Type Comment Address/Value
3 wall Tast! oM
4 Wal2 Tast2 01
B} Test3 14
5] Testd 21
7 Tasth 215
a 100
] 200
10
MZ25 - S|
A B o] ] E F
1
2 MName Data Type Comment Address/alue
3 vall Test] 0m
4 Val2 Test? 01
5 Val3 Test3 11
] Vald Testd 21
7 Vals Testh 215
a Valf 100
] Wal7 200
10
11
G16 - £
A B C [u] E F
1
2 MName Data Type Comment Address/ alue
3 KED BOOL Testl 0
4 Wal? BOOL Test? 01
] Wal3 BOOL Test3 11
& Wald BOOL Testd 21
7 Walh BOOL Testh 215
g el UINT 100
] Walf LINT 200
10
[Ei] - I |
A B C D E
1
2 arme Data Type Comment  Address/Value
& Val BOOL Test om
4 Val2 BOOL Test2 01
5 Val3 BOOL Test3 11
] Val4 BOOL Test4 21
7 Val BOOL Testd 215
g Val6 UINT 100
9 Val7? LINT 200

‘

EE[EEEEE

2ERBERE

MEEEEE
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Eﬂ Additional Information

For a BOOL variable, enter a value in a range of 00 and 15 to two decimal places of the
address.

If the value of decimal places is not set to the address of the BOOL variable, a tag
comparison error occurs when the NA starts.

Example) 0000.00
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